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PDF is the de facto standard for sharing or distributing electronic documents. There are many PDF utilities to choose from when you want to create, edit and view PDF documents, but here's a look at five of the best tools to work with PDFs. Earlier this week, we asked you to name your favorite PDF utility (or utilities) and now we're back with the results. Four
of the most popular choices are good old standards, having been on our previous list of the top five PDF readers. These four, plus Nitro PDF, are highlighted below. Adobe created the Portable Document Format, but that doesn't mean that the company's Acrobat suite... Read moreFoxit (Windows/Linux, Reader: Free, Pro: $129)G/O Media can get a
commissionFoxit Reader is a free PDF reader with a small footprint, but a number of features including pdf tagging and commentary, advanced multimedia insertion, five levels of security and even the ability to run JavaScript in the document. There are other versions of Foxit that serve different purposes: PDF Creator ($29.99) converts other pdf file formats,
PDF Editor ($99) lets you modify any part of the PDF file, and the FOXIT Phantom PDF set ($129) includes all of the above, plus others, such as comparing PDF files. Preview (Mac, Reader: Free)Preview is the PDF viewer built into the Mac. In addition to quickly opening PDF files, Preview on Mac OS 10.5 (Leopard) lets you write down PDFs (highlight
sections, add notes or links), rearrange PDF pages, merge PDFs, and add keywords to your file for easy Finder search. Preview is also a pretty decent image viewer with some editing capabilities. PDF-XChange (Windows, Reader: Free, Pro: $34.50)Voted the best PDF reader in a previous Hive Five, PDF-XChange is a lightweight and fast PDF reader with
a long list of features including page markup, document export or pages for images, text extraction, support for 256-bit AES encryption, customizable interface, and more. The Pro version includes more page manipulation features, conversion tools, and PDF creation. Last week we asked you to share your favorite PDF reader and then we gathered the results
and put Read moreAdobe Acrobat (Windows/Mac, Reader: Free, Pro: $299)Acrobat Reader is Adobe's free PDF preview tool that is most commonly integrated into people's browsers. It offers feedback tools, integration with Acrobat.com online services and a protected way to protect your computer from malicious PDFs. While not as fast as other pdf viewed,
Reader has the widest access to all types of content embedded in PDF files. To create, edit, and feature more advanced, you'll need to upgrade to the Standard version 299) or Pro ($449) or get the Suite ($1,079) — something probably more appropriate for businesses, given the price. Nitro PDF (Windows, Reader: Free, Pro: $99)Nitro Reader is a free PDF
viewer that is currently in Beta but offers advanced features like PDF creation, text conversion, typing typing anywhere on a page, save forms and view PDF files in Outlook or Windows Explorer. Upgrade to nitro PDF Express ($49.99) for PDF creation and page manipulation features —including unique batch processing functionality—or Nitro PDF
Professional, Acrobat's original alternative to almost everything else you need to do with PDFs.Now it's time to choose the best global PDF tool. Have a favorite feature that makes your PDF tool of choice stand out? Let us know in the comments. A PDF splitter is used to join a PDF file into pieces. You can split pdf pages if you want only one or two (or more)
pages of the document and the rest to be removed, or if the PDF is too large for whatever you want. Pdf splitting may seem like a complicated procedure, but it's actually very easy to do. There are several online PDF splitters and offline programs that can split PDFs in just a few clicks. In fact, you may even already have a program installed on your computer
that can split PDFs into multiple files. Most pdf page splitters below give you a few options for splitting the PDF: blast the document into multiple files where each page of the original becomes your own PDF, extract one (or more) specific pages from the PDF, or delete specific parts of the PDF so you get only the part of the original you want. When extracting
specific pages from the PDF, you are often given the option of dividing the PDF in half so that one PDF keeps the first half of the pages and the other has the second half. For example, you can split a 100-page PDF in half so that you have two separate PDFs, each with 50 pages. Another way these PDF splitters work is to allow you to split the PDF by
choosing a series of pages. Maybe your PDF has 225 pages, but you only want pages 10-50 and 223-225. In this scenario, you would divide the PDF into two separate PDFs, both containing only the pages you chose to extract. Some pdf splitters even allow you to merge your split page ranges—for that, the PDF would contain only pages 10 through 225,
with 1-9 and 51-222 removed. Some of the best PDF dividers can also divide the document by size, a perfect solution if your PDF is too large to load on a website, send by email, etc. Simply choose the size you want each PDF piece to be and the program will divide the PDF into as many pieces as needed to ensure that each file is below the specified size.
The iLovePDF website is one of the easiest ways to split the pages of an online PDF into separate individual PDFs. You can upload a PDF from your computer or through your Dropbox or Google Drive account. When you choose your PDF, you have two options, to divide the PDF by page intervals or to extract all pages from the PDF. The Split option Range
also allows you to merge all the extracted tracks into a PDF, essentially removing some pages from the original PDF, but leaving everything else (the chosen pages) intact. The Extract of all pages pages in iLovePDF is self-explanatory: each page will be extracted in its own PDF. For example, if your PDF has 254 pages, you will have a ZIP file of 254 PDFs.
The free online PDF splitter from Sejda is very similar to iLovePDF, but allows you to view all pages before viewing them. In addition to uploading PDFs from your computer, Dropbox, OneDrive, or Google account, this site can also import PDFs by URL. Once the document is uploaded to Sejda, you have four options of how you want to split the PDF pages.
You can extract each page to a separate PDF, select which pages you want to split, split all pages, or split each even page. Files uploaded to this site are automatically deleted after two hours. All of these PDF split options are easy to understand, except for the Split all X pages option. For example, if you have a 12-page PDF, you can split every two pages
to make six separate PDFs. If you use Google Chrome's web browser, you can easily use it as a PDF tab to save only one page (or a series of pages) to a PDF file. Because Google Chrome works like a PDF printer, it means you can print any file in a PDF file and save it to your computer. Because Chrome can also open and read PDFs, you can combine
these two into an easy-to-use PDF splitter feature. Here's how to split specific pages of a PDF with Chrome: Either open the PDF online using your URL or with the Ctrl+O (Windows) or Command+O (Mac) keyboard shortcut to open a local PDF from your computer. Choose to print the page as normally printing in Chrome to save a copy on paper, but don't
print it! Use the Destination drop-down menu to choose Save as PDF. Select the pages drop-down menu and select Custom. Enter the pages you want to split from the PDF. For example, to save only the second page of the PDF, you would type 2. You can also print other pages at the same time, and even multiple entire tracks of pages—just separate
everything with visions. Another example where Chrome would split the PDF so as to save only pages two and four to six, would be to type 2.4-6.Choose Save. Smallpdf is similar to other pdf splitters online, but has a lot more options if you want to do more with your PDF than just cut a few pages. You can keep your PDF online and do all kinds of things
clean with it. After uploading your PDF, you have two very easy-to-understand choices when it comes to PDF splitting: extract each page into a separate PDF (this is not free) or select which pages to extract to make a custom PDF. If you choose the option to make individual PDFs on each page of the PDF, you can download each page separately, get all of
them in a ZIP file and rotate the PDF pages. If you select individual pages to separate from the PDF, you can see a preview of the pages and select which ones you want. Some PDF splitters make this harder than it has to be, but Smallpdf does it Well. After splitting the PDF, extracting the pages you don't want, you can even convert the PDF into Word,
compress it, mesclate it with other PDFs and edit it on the smallpdf site. Another unique feature in Smallpdf is that you can merge some of your PDF pages with selected pages from a different PDF. This is perfect if you need to attach certain pages of multiple PDFs and want to avoid the average extraction and fusion processes. Everything you upload to
Smallpdf is automatically removed after an hour for privacy reasons. Use PDF for PNG if you want to separate your PDF into PNG files instead of PDFs. There is also the PDF to JPG site to divide the PDF into JPGs. These sites essentially divide each page of the PDF and then convert each page into an image format. There are no custom options here —
just an upload button and a download button. Downloads are saved in ZIP format. PDFsam is a free PDF editing package that merges, extracts, rotates and divides PDFs. Pdf split options are almost identical to adobe acrobat (below), but this program is 100% free to use. You can split the PDF after each page to get a separate PDF for each page in the
document. You can also split the PDF on each even or odd page. PDFsam can split the PDF into two separate PDFs, too by choosing a page number. This will create one PDF with all the pages before the chosen number and another with each page after it. Another option is to have the PDF divided by each page n. This is similar to the even/odd option, but
gives more options. For example, if you have a PDF with 100 pages and choose to split it after every 7 pages, you will receive 15 PDFs — 14 with 7 pages and another with two. If your PDF has bookmarks or is too large, use the Split by Bullets or Divide by Size option. To extract specific pages from the PDF, use Extract and choose which pages or tracks of
pages, you want to export to a new PDF. Like PDFsam, Adobe Acrobat is a great way to split PDFs into multiple parts. You can choose to divide by the number of pages, file size, or top-level markers. For example, if you have a 6-page PDF that you want to split so that each document has only two pages, you can choose 2 as the Number of Pages to split
the PDF, and Adobe Acrobat will do three parts to the PDF, each containing two pages (to make up the six total pages). Adobe Acrobat also makes it easy to send really large PDFs by email or to upload them to sites that don't accept large PDFs. Use the File Size option to split the PDF into chunks that are small enough to be accepted wherever you're
using. The pdf split option in Adobe Acrobat is in the Tools menu—choose the Arrange pages option and select which PDF you want to split. In older versions of Adobe Acrobat, use the Tools &gt; &gt; Split Document. If you already own Microsoft Word, it's super easy to use it as a PDF splitter. However, you don't, there's no need to buy Word just to use it as
a splitter when there are better (and free) options out there. The way it works is that you have to first open the PDF in Word for editing. When it's time to save the PDF and choose which pages to keep, you'll essentially be splitting the PDF. Here's how: Use the File &gt; Open menu to find the PDF. It may be easier if you change the file extension drop-down
option to PDF Files (*.pdf). If you see a message about Word having to convert the PDF into an editable document, choose OK. Depending on the size of your PDF, amount of text and number of pages, this can take a long time. Press the F12 key or go to File &gt; Save As, to open the save dialog box. If you see a message about Protected View, select
Enable Save. Decide where to save the new document. Give it a different name if you are saving it to the same location as the original PDF. From the Save as drop-down type menu, choose PDF (*.pdf). Select the Options button. In the pange range area at the top, select the bubble next to Page(s). Decide how you want Word to split the PDF. To just extract
one page from the PDF and remove all the others, type the same page number in both text boxes, otherwise choose a series of pages to keep. Choose OK. Select the Save button in the dialog box. Now you can exit Word. PDFelement Professional is another complete PDF editing suite that is not free, but provides tons of options for editing, compressing,
protecting, and splitting a PDF, among other things. With your PDF open, go to the Page tab and use split to see a screen similar to the one you see above. You can divide the document by number of pages or by top-level markers. If you use the Extract option, you can choose which PDF pages should be saved, which will remove the missing pages from the
PDF. Or, just right-click and delete all the pages you want. You can also use PDFelement to rotate specific pages in a PDF, join pages to make a single image, replace or add pages with those of another PDF, insert blank pages, print specific pages, extract form data, add a password, cut pdf pages, save PDF pages in various file formats (images, Excel,
Word, TXT, HWP, etc.) and more. This program takes away the guesswork of what will happen when you select certain options. Just choose the Split option in the main window and choose from any of the four PDF split options. Each option has a small explanation in the program, clearly explaining what will happen if you follow through with this option. This is
not common in pdf splitters or other PDF editing programs, so this is something to think about if you go with this program. You can save each page in a separate PDF, group together to divide the PDF into pieces, choose which pages should be deleted from the PDF, and divide the PDF into groups of so many pages. In addition to adding a password to the
PDF and being able to merge multiple PDF pages together, this program just just as a PDF splitter — perfect if you don't want to mess with tons of other editing options. As the name implies, A-PDF Split is a PDF splitter. There's not much in this program except for PDF split skills, but it does well and has some unique features worth noting. For starters, this
program works much like the others on this list. You can choose a page range to split the PDF, make a separate PDF for each page of the document, or split it after every so many pages. If there are embedded bookmarks, you can split the PDF by them as well. The A-PDF Splitter can also extract certain pages from the PDF to separate them from the
original file, or you can choose which pages to remove. The Advanced Sets option is the same as a multi-range option in the other PDF splitters above, only in an advanced part of the program. Thus, you can use it to split pages 1-4 and 8-15, for example, to quickly remove the middle pages. In the settings is an option to enable the right-click context menu
option to easily open PDFs in this program. Program.
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